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Getting Started 
Basic Information 

To ensure you have ample time to complete this project there are some things 
that you should take into consideration ahead of time. The purpose of this 
document is to guide you in all areas of this project. You will use the New 
Media Center (NMC) and it is expected that you will complete the digitizing 

steps described in this manual in one sitting – start to finish. You should not save files 
on the desktop in the NMC and you should not save uncompressed video for editing 
at a later date. For the papers you will be writing in this class – each approximately 6 
pages – you should not include more than five clips or fewer than three. It should take 
approximately one hour to digitize, edit and compress this amount of video if you 
follow the steps outlined in this document as well as some of the suggestions listed 
below. 

Items Needed 
Once you have selected the film you will be using you will need to bring it along with 
the following items to the MIT New Media Center: 

" Exporting Zip Disk (PC or MAC formatted) – Save the converted, edited 
your video with the and compressed video files on this disk (steps explained later in 
settings required will detail). These files will be imported into your Microsoft Word 
only allow you to 
store approximately document. Submit the entire project on this disk. 
9-13 minutes of video 
on one zip disk. CD-R/CD-RW (optional) – This is an optional storage method 

for those that would prefer to store their files on a CD-ROM. 
Note: you should save your video files on a CD-RW instead of a CD-R so that you 
may use this same disk to save your Microsoft Word document once the files have 
been imported. Projects may be submitted on CD-ROMs. 

Headphones (optional) – The computers in the media lab are not equipped with 
headphones. If you would prefer to use headphones instead of the computer’s 
speakers you must bring your own. 

The New Media Center (NMC) 
The New Media Center at MIT houses the hardware and software needed to complete 
this project. Please be advised that there is only one station in the NMC where you 
may convert from analog to digital. Please allow yourself ample opportunity to 
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complete this project. As noted in the class syllabus, not having time to digitize will 
not be an acceptable excuse for incomplete projects. 

The NMC is located in 26-139 and is accessable 24 
hours a day 7 days a week with the exception of 
those times when it has been reserved. Please refer 
to the NMC website for details on scheduling 
http:/web.mit.edu/nmc/home.html. The passcode 
for the door’s secure keypad is available by typing 
“tellmenmccombo” at the Athena prompt. While 

there are 15 Macintosh Power Mac G4 staions in the NMC only one of them has the 
Sony Media Converter box and VCR hookup needed for converting analog to digitital. 
This station is located in the farthest right corner of the room (i.e., when facing in – 
door to back). If the computer is not on you will need to enter a user name and 
password when loggin on. Currently the user name is “tempnmc” and the password is 
“tempnmc.” Please consult the dry erase board in the NMC for updates on this 
information. (Note: the password taped to the front of the monitor is not in use at 
this time.) 

Currently the NMC is only staffed from 11 am to 1pm on Friday. Support assistance 
is available by emailing questions or requests, however, it can take up to 48 hours 
to receive a response. 

Tips 
Digitizing is a relatively simple process, but there are a few things to keep in mind to 
ensure it remains as such. Note the sections of the video tape that you want to digitize 
– use the timer on the VCR – and record the start and end time of each clip. Try to 
keep these clips short. The clips are meant to provide a complimentary example for 
your paper and should not be more than 1-2 minutes in length per file. With the 
settings that are required you will not be able to save more than 13 minutes of video on 
a 100MB Zip disk. 

Cue your video tape to the first clip you would like to digitize before arriving at the 
NMC so that you may begin working immediately. Click the Import button a few 
seconds before the beginning of the scene you would like to record and click it again a 
few seconds after you would like the scene to end. This will ensure you have the full 
clip on the first take. You will be able to remove/crop the extra materials during the 
editing process. While it is not always possible to have clean breaks in every clip (e.g., 
at the beginning of a particular dialog) – and you should not spend a great deal of time 
attempting to perfect the movie editing process – try to make each clip contain ONLY 
what you want it to contain. This will keep your file sizes small and your digitizing time 
in the NMC within the timeframe noted earlier. Preview each clip after you have 
converted and edited. Compressing the file with QuickTime takes approximately 80 
seconds for 10 seconds of video. Going through this process only to discover that you 
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didn’t include the entire scene that you intended to include will add unwanted time to 
the process. 

Digitizing 

Cables 
The cables should be connected properly when you arrive at the NMC. However, to 
avoid time spent troubleshooting digitizing problems arising simply from improper 
connectivity, please take a moment to ensure that the cables are set up correctly from 
the VCR to the G4 and the Sony Media Converter box. See Figure 1 for directions. 

a.) S video IN 

e.) FIREWIRE 

b.) S video OUT 

c.) L Audio In 
d.) R Audio In 

a. Connect cable to S 
Video In on converter 

b. Connect cable to S 
Video Out on VCR 

c. Connect L Audio In 
cable from converter 
box to VCR (Audio 
Out) 

d. Connect R Audio In 
cable from converter 
to VCR (Audio Out) 

e. Connect Firewire from 
G4 to converter 

CABLES 

Fig. 1 

Turning on Hardware 
If not already on please turn on the following: 

1. TURN ON the Sony Media Converter box - green light should be 
on. Push Analog In button if not lit. 

2. LOG ONTO the Macintosh Power Mac G4 - enter user name and 
password if necessary. This information may be found on dry erase 
board in room. If using headphones plug into back of machine. 

3. TURN ON the VCR power - insert video and push the stop button 
(the video may begin to play automatically otherwise). 
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Using iMovie 
OPEN iMovie by clicking on the program icon at the bottom of the screen 
or going to the Apple menu. 

You should be prompted to start a new project folder when the program opens. If 
you are not prompted to start a new project then there may be an open project on the 
computer. Close the project from the file menu and then select New Project. 

Select New Project. Name project folder 
and temporarily save it on the computer 
desktop. If you are not prompted to open a 
new project go to the File Menu and select 
New Project from the drop down list. 
Name this folder and save it to your 
desktop. 

The iMovie window will now open. Push Play on 
the VCR. You should now see the movie playing 
in the recording window on the left of the screen. 

If you do not see your movie check that the Input/Edit 
slider is pushed to the left – toward the camera icon. 

At the bottom center of the recording window 
you will find the iMovie controllers. Click on 
the Import button to begin recording your 
video. Click on the Import button again to 
stop recording. Push Stop on the VCR. 

The segment will now appear in the window on the right – the “shelf” and will be 
named Clip1. 

Cue the video tape to the next segment you want to digitize and 
repeat these steps until you have all the clips that you need. As 
you create each clip they will appear in the 12 paned shelf on 
the right. 
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Editing Clips 
Once all of the clips have been digitized it is time to edit each 
one so that any unwanted parts may be cropped out or deleted. 
You will not be able to save the project folder that you currently 
have on the computer desktop without compressing each clip 
first – uncompressed video files are too large to save on a Zip 
disk or CD-ROM. 

Making a copy of the clip you want to edit BEFORE you edit it 

& Your 
empty 100MB 
zip disk will only 
hold about 25 
seconds of 
uncompressed 
digital video 

will save you time in the end should you encounter any problems and need to start 
over. Click on the clip you want to copy to highlight it; select Edit from the above 
toolbar; select Copy; click in the lower gray box - the editing bay – so that it is selected; 
select Edit again from the toolbar; and select Paste. Your copy should now appear in 
the editing bay. 

Alternately, you may choose to simply drag the clip with your mouse into the lower the 
editing bay of the iMovie window 
without making a copy beforehand. 
However, once you edit and crop the clip 
the changes are permanent. You will 
need to go through the digitizing process 
again to obtain the clip. 

The clip should now appear in the iMovie recording window. Use the controls 
(pictured on page 4) to play the clip. Note: if you are having any problems viewing 
the clip make sure that the Eye simple (left) is selected and NOT the clock. 

As the clip plays you will notice the movie play head below that follows each frame. 
The play head also displays the play time of the movie. Use your mouse to click on the 
hash marks on the bottom of the timeline and small gray triangles will appear. Note: 
You must click and drag on the hash marks for the triangles to appear. Use the 
triangles to crop out sections of your clip. Drag one triangle to the left to set the 

beginning point of your clip. Drag the other triangle to the right of the timeline and set 
where you would like the movie to end. Click on the Play button to preview your new 
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clip. This step may require some time to master – getting acquainted with cropping 
scenes. 

Once you are satisfied with the beginning and end of the movie go to the Edit menu 
and choose Crop. You may also use the Delete button on your keyboard. The extra 
parts of the clip will be removed. Should you have any problems with this step you can 
delete the clip in the editing bag and simply drag its copy from the shelf into the editing 
bag to start over. 

Compressing & Saving Files 

When you are done editing Clip 1 you will need to compress it 
by exporting it was a QuickTime movie file. Go to the File 
menu and select Export Movie. 

Select Export movie to QuickTime; set its format to CD-ROM 
Movie Medium and click Export. This creates a movie 

approximately 320 x 240 pixels. When 
prompted to save your movie select your 
Zip disk and name the file something 
descriptive. 

The compression process takes some 
time to complete depending on the 
length of your clip – approximately 80 
seconds for each 10 seconds of video. 

To edit your remaining clips, drag the previously edited clip back to the shelf and drag 
the next clip down to the editing bay. When you are done with each clip – and each 
clip has been saved to your Zip disk – choose Quit from the File menu. When 
prompted to save this project click Don’t Save. Drag your project folder into the trash 
can and empty the trash. DO NOT leave your project folder and its files saved on 
the computer desktop. 
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Importing Movie in Word 

There are two methods for importing your movie files into your Word document. 
These methods vary slightly and depend on the version of Microsoft Word you are 
using – PC Word or Macintosh Word. Note: you must have QuickTime installed on 
your computer in order to import the files into Word. 

If you do not have QuickTime please go to the following URL 
(http://www.apple.com/quicktime/download) and download the free player before 
continuing. 

PC Word 

Open your Word document and find the areas where you will be importing your clips. 
Create some space for the imported file in the document as seen in Figure 2. Move 
your cursor into the blank space you have just created and select Center from your 
toolbar for the new paragraph alignment. 

Go to Insert and select Object. Select QuickTime Movie as your object and click OK. 
Select the Create from File tab; select Link to File; locate your Zip drive and select a 
movie file. Click OK. The QuickTime icon will now appear in your Word document. 
To view the file double-click on the icon. A pop up box will appear warning you that 
you are about to activate an embedded file; Click OK. The QuickTime player will now 
open in its own window. Use the controls to play your movie. Repeat these steps for 
each clip that you add to your paper. Save your Word document. 

PC WORD DOCUMENT 

mmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmm 
mmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmm 
mmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmm 
iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii 
iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii 

tttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttt 
tttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttt 

Fig. 2 
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Macintosh WORD 

Open your Word document and find the areas where you will be importing your clips. 
Create some space for the imported file in the document as seen in Figure 3. Note: 
Because Macintosh Word will show the movie window in full rather than just the 
QuickTime icon you will need to reserve more space before importing. 

Go to Insert and select Movie – browse to find your movie on your Zip disk. The 
movie will import at its full size. Position the QuickTime player where you want it and 
preview the file. Repeat these steps for all of your clips.  Save your Word document. 

Macintosh WORD DOCUMENT 

mmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmm 
mmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmm 
mmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmmm 
iiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiiii 

tttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttt 
tttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttt 
tttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttt 
tttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttttt 

Fig. 3 
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